Introduction
Triggers and actions are the building blocks that you can use to create interactivity and custom features. Once you understand how these building blocks work, it is up to you and your imagination to create whatever interactions, games, and custom features you want.

A trigger is what you add to an object or page that launches an action. The action is what actually happens.

For example, you could:
- Add a trigger to a button to go to the next page.
- Add a trigger to a page that shows a layer if the student passed the test.
- Add a trigger via a text hyperlink to take a user to a webpage.
- Add a trigger to a shape that changes the state of a character.

You can “layer” actions so that several things happen on a single click (such as displaying a message, playing a sound, and adding points to a score).

In this chapter, you’ll learn about the available trigger and action options that can be applied to virtually any object. Plus, you’ll learn about certain objects that are specifically designed for interaction: hyperlinks, buttons, check boxes and radio buttons, hotspots, and markers.

In the next chapter, you’ll learn about more advanced action options, such as how to make actions conditional.

In This Chapter
- Elements of an Action
- Event Types
- Action Types
- Adding and Managing Actions
- Hyperlinks
- Buttons, Check Boxes, and Radio Buttons
- Hotspots
- Markers
- Individual Actions
- Drag-and-Drop Interactions
Notes
## Elements of an Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Target</th>
<th>Event</th>
<th>Object</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump to slide</td>
<td>2.1</td>
<td>when the user clicks button 1</td>
<td>every time (no condition).</td>
<td></td>
</tr>
<tr>
<td>Change the state of</td>
<td>character 1</td>
<td>when the user hovers over</td>
<td>character 1</td>
<td>every time (no condition).</td>
</tr>
<tr>
<td>Play</td>
<td>cheer.mp3</td>
<td>when the user clicks Submit button</td>
<td>if choices A and C are selected.</td>
<td></td>
</tr>
</tbody>
</table>

Some actions have additional fields (such as the state change shown below) and some have fewer fields.
Event Types

There are 14 different events that can trigger an action. The one you choose affects what options you have in the **Object** drop-down menu.

<table>
<thead>
<tr>
<th>Event</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>User clicks</td>
<td>These events can be applied to just about any object visible on the slide: buttons, text boxes, shapes, images, characters, etc.</td>
</tr>
<tr>
<td>User double clicks</td>
<td></td>
</tr>
<tr>
<td>User right clicks</td>
<td>An action with this event triggers when the student clicks anywhere BUT the target object.</td>
</tr>
<tr>
<td>User clicks outside</td>
<td>You can base this event on the <strong>Timeline</strong> of the slide as a whole, a layer, or an individual object.</td>
</tr>
<tr>
<td>Timeline starts</td>
<td></td>
</tr>
<tr>
<td>Timeline ends</td>
<td></td>
</tr>
<tr>
<td>Object dragged over</td>
<td>These events are used for drag-and-drop activities. For example, you might want a shape to glow when an object is dragged over it, and then display a message if the student drops the drag item there.</td>
</tr>
<tr>
<td>Object dropped on</td>
<td></td>
</tr>
<tr>
<td>User presses a key</td>
<td>You indicate what keystroke combination triggers the action. You can include functional keys such as <strong>Shift</strong>, <strong>Ctrl</strong>, <strong>Alt</strong>, arrow keys, etc.</td>
</tr>
<tr>
<td>State</td>
<td>The event triggers when the state of one or more objects changes to a certain state or to anything but a certain state. (See details on the right.)</td>
</tr>
<tr>
<td>Variable changes</td>
<td>A variable is a saved piece of information. Learn more about variables in chapter 11.</td>
</tr>
<tr>
<td>Mouse hovered over</td>
<td>This event can be applied to just about any object visible on the slide.</td>
</tr>
<tr>
<td>Media completes</td>
<td>You can use this event to trigger an action when an audio or video file finishes playing.</td>
</tr>
<tr>
<td>Control loses focus</td>
<td>Actions with this even are triggered when the student clicks off of the item with the trigger, such as off of a data entry box</td>
</tr>
</tbody>
</table>

**Click Events**
- User clicks
- User double clicks
- User right clicks
- User clicks outside

**Timeline Events**
- Timeline starts
- Timeline ends

**Drag Drop Events**
- Object dragged over
- Object dropped on

**Other Events**
- User presses a key
- State
- Variable changes
- Mouse hovered over
- Media completes
- Control loses focus

State events have several components:
- Select one object or multiple objects to consider. **(A)**
- With multiple objects, designate if all have to change or just any one of them. **(B)**
- Indicate if you want to pick a state that triggers the action (is/are) or the only state that doesn’t trigger the action (is not/are not). **(C)**
- Finally, designate the state to trigger or not trigger the action. **(D)**
There are 21 different action types. The one you choose affects what options you have for the target and if there are any other choices to be made.

Some of these actions are covered in this chapter, while others are covered in a later chapter.

<table>
<thead>
<tr>
<th>Action</th>
<th>Brief Description</th>
<th>Covered on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change state of</td>
<td>For an object with multiple states, designate which state to show.</td>
<td>page 122</td>
</tr>
<tr>
<td>Show layer</td>
<td>On slides with multiple layers, use these actions to show and hide them.</td>
<td>page 122</td>
</tr>
<tr>
<td>Hide layer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jump to slide</td>
<td>Hyperlink to other slides in your project.</td>
<td>page 123</td>
</tr>
<tr>
<td>Jump to scene</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lightbox slide</td>
<td>Display another slide as a pop-up window on top of the slide you are on. (And then close that pop-up window.)</td>
<td>page 124</td>
</tr>
<tr>
<td>Close lightbox</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Play media</td>
<td>Control media such as an audio or video file.</td>
<td>page 125</td>
</tr>
<tr>
<td>Pause media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stop media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Submit interaction</td>
<td>Grade a question made from one of the quiz templates.</td>
<td>page 180</td>
</tr>
<tr>
<td>Restart course</td>
<td>Go to the starting scene and reset everything (questions, variables, states, etc.) to the original settings.</td>
<td>page 126</td>
</tr>
<tr>
<td>Exit course</td>
<td>Close the course.</td>
<td>page 126</td>
</tr>
<tr>
<td>Adjust variable</td>
<td>Change the value of a stored piece of data.</td>
<td>page 134</td>
</tr>
<tr>
<td>Jump to URL/File</td>
<td>Go to a webpage or launch an attached document.</td>
<td>page 127</td>
</tr>
<tr>
<td>Send email to</td>
<td>Open an email in the student’s default email program, addressed to the address designated.</td>
<td>page 128</td>
</tr>
<tr>
<td>Execute JavaScript</td>
<td>Add custom JavaScript code to extend the capabilities of the software.</td>
<td>page 128</td>
</tr>
<tr>
<td>Submit results</td>
<td></td>
<td>page 180</td>
</tr>
<tr>
<td>Review results</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset results</td>
<td>Process the results of a quiz.</td>
<td></td>
</tr>
<tr>
<td>Print results</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding Action Triggers

All action triggers on a slide can be found in the Triggers panel. They are organized into three categories:

- **Slide Triggers**: These actions trigger when the Timeline starts or ends.
- **Object Triggers**: These actions trigger based on the state of or an interaction with a specific object.
- **Player Triggers**: These actions are triggered when the student clicks a player button: the Next, Prev, or Submit buttons.

Buttons at the bottom of the Triggers panel let you manage the triggers.

Add a New Trigger

One or more actions can be added to any object except web objects.

**To add a new trigger:**

1. Select the object you want to add the trigger to (optional).
2. Click the Create New Trigger button.
3. In the Action drop-down menu, select the action you want.
4. In the second menu (field name changes based on the action type chosen), select the target for the action.
5. In the When drop-down menu, select the event that will trigger the action.
6. In the Object menu, select the item to be used as the trigger.
7. Click the OK button.

There may be additional settings based on the action you choose (such as Navigation controls in the example shown). These settings will be taught with the corresponding action.

Conditions are covered in chapter 11.
You can edit all aspects of a trigger in the **Trigger Wizard**. You can edit blue hyperlinked attributes of a trigger in the **Triggers** panel.

**To edit a trigger in the Trigger Wizard:**
1. Select the trigger.
2. Click the **Edit trigger** button.
3. Make your changes in the wizard.
4. Click the **OK** button.

**To edit a trigger attribute in the Triggers panel:**
1. Click a blue hyperlinked attribute.
2. Select a new value from the drop-down list.

**BRIGHT IDEA**

When you add a button to your slide, an unconfigured action is added to the **Triggers** panel. Click the **Add trigger** hyperlink to bring up the **Trigger Wizard** for the button.

---

**Manage Action Triggers**

**Copy, Paste, and Delete**

To copy and paste or delete selected triggers, use the buttons at the bottom of the **Triggers** panel or keyboard shortcuts:

- Copy = **Ctrl + C**
- Paste = **Ctrl + V**
- Delete = **Delete**

**Trigger Order**

If you have an object with multiple triggers, the order of the triggers may be important. For example, if you have a game with a score, you’ll want to make sure you add or subtract the student’s points before running any actions based on those points. Triggers fire from top to bottom. You can rearrange them by using the **Move up** and **Move Down** arrows.
Interactive Objects

You can make just about any object interactive. However, certain objects are specifically designed to be interactive:

- **Hyperlinks**: Hyperlinks let you create a text link with one or more actions.
- **Buttons**: Buttons come with interactive states already set up (such as hover, down, visited, etc.) and one trigger already attached.
- **Check Boxes** and **Radio Buttons**: Use these for custom form elements or questions.
- **Hotspots**: Hotspots are interactive shapes that the student can’t see in the published course, but that you can see in the authoring environment. They have one trigger attached already and are usually placed over part of an image that you want the student to click.
- **Markers**: Students click or rollover an icon to view a pop-up window with text and/or media.
- **Data Entry** boxes: This is a text entry box that the student can type into. You can save the information to be used later in the course. You’ll learn about data entry boxes in chapter 11.
- **Questions**: You’ll learn more about questions in chapter 12.

**Add a Hyperlink to Text**

Hyperlinks have a default configuration to go to a webpage or launch a document when the user clicks the text.

**To add a hyperlink leading to a webpage:**
1. Select the text you want to hyperlink.
2. Go to the **Insert** tab.
3. Click the **Hyperlink** button.
4. In the **File** field, enter the web address you want.
5. Click the **Browser options** button to configure the properties of the browser window.
6. Click the **OK** button.

**POWER TIPS**

Even though the **Trigger Wizard** is configured to launch a webpage or document, you can still change any of the fields if you want to set up a different action.

You can apply more than one action to the hyperlink in the **Triggers** panel.
To create a button:
1. Go to the **Insert** menu.
2. Click the **Button** drop-down menu.
3. Select one of the two button options.
4. Click and drag your mouse on the slide to draw the button.
5. Type the text for your button, if needed.

**Button Actions**
Unlike a hyperlink, the **Trigger Wizard** does not automatically appear when you add a button. There is one trigger already attached, which can be configured in the **Triggers** panel. You can also add additional triggers there.

**Button States**
Buttons automatically come with 6 states:
- Normal: the object as originally created
- Hover: what shows when the student hovers over it
- Down: what shows while the student clicks it
- Visited: what shows after it has been clicked once
- Disabled: what shows when the button is inactive
- Hidden: nothing is shown (This option does not appear with the other options since it cannot be edited.)

You can change the appearance of these states and add or delete states like you can with any other object.

**Button Formatting Options**
You can format buttons the same way as other shapes, such as changing the size, color, outline, glow, etc.

**Icon Buttons**
Rather than creating a text button, you can also pull from a library of icons for your buttons.

**To add an icon to a button:**
1. Go go the **Button Tools: Format** tab.
2. Click the **Button Icons** gallery drop-down arrow. (A)
3. Select the icon you want.
4. Use the drop-down menus next to the gallery to change the alignment and color of the icon.
Add Check Boxes and Radio Buttons

Check boxes and radio buttons are individual interactive elements that you can use to create custom form or question functions.

To add a check box or radio button:
1. Go to the Insert tab.
2. Click the Button drop-down menu.
3. Select the check box or radio button you want.
4. Click on the slide to place the object.

Actions
Check boxes and radio buttons do not come with any actions attached, and they often don’t need any. More often than not, you’ll use the state of these objects as a condition for an action somewhere else. For example, you might have a Check My Answer button that shows one layer or another based on which check box is in the Selected state. If you do want to add actions, you can do so in the Triggers panel.

Add a Trigger, p. 114
Conditions, p. 138

States
Check boxes and radio buttons come with similar states as buttons, with one exception. Instead of a Visited state, they have a Selected state, which, as the name implies, means the object is selected.

Add Check Boxes and Radio Buttons

Formatting Options
Check boxes and radio buttons have many of the same formatting options as other objects. One major difference is that you can format the box/circle as well as the checkmark/dot.

Object Properties, ch. 6
Arranging Objects, ch. 7

Labels
To add a text label to the check box or radio button, just select the object, and start typing.

DESIGN TIPS
• Check boxes are square and let the student select more than one. Radio buttons are round, and only one can be selected at a time.
• Many question slides use check boxes and radio buttons. Depending upon what you are doing, it may be quicker to use a quiz slide, or it may be quicker to add the individual elements yourself.

BRIGHT IDEA
Be sure to indicate whether you want the initial state to be Normal (not selected) or Selected. You can do this from the States tab or by selecting it on the slide.
Hotspots are interactive shapes that the student cannot see in the published course, but that you can see in edit mode. You can make oval, rectangle, and freeform shapes.

To add a hotspot:
1. Go to the Insert tab.
2. Click the Hotspot drop-down menu.
3. Select the shape type you want.
4. Click and drag your mouse to draw the shape on the slide.

As with buttons, you can format hotspots using standard formatting options and assign the action in the Triggers panel.

Create a Button Set

When you have more than one radio button, the student can only select one. If the student then selects another one, the first one is automatically deselected. But what if you want to have two sets of radio buttons on a page as shown? The student would need to select one radio button in each set, not just one radio button out of all five. You can do that by assigning the radio buttons to different button sets. Only one item can be selected at a time in each button set, and each button set works independently from other button sets.

To add object(s) to an existing button set:
1. Select the objects.
2. Right-click them.
3. Select Button Set.
4. Select the button set you want.

To add object(s) to a new button set:
1. Select the objects you want in the new set.
2. Right-click them.
3. Select Button Set.
5. Enter a name for the new set.
6. Click the Add button.

POWER TIP

Button sets aren’t just for radio buttons! You can create a button set for three characters or three buttons, for example. When one is selected, the others are deselected.

Add a Hotspot

Do you currently keep a to-do list?
- Yes
- No

If so, what type of list do you use?
- Outlook
- Online list
- Paper list

New Button Set
- Name:
- Add
- Cancel

DESIGN TIP

Which do you use: hotspot, button, or graphic with a trigger attached? In many cases, all three options would work just fine, and it comes down to a matter of personal preference. Here are a few factors to consider:

- Buttons already have interaction-related states attached (hover, visited, etc.), which might save you time.
- Shapes with triggers manually attached may take longer to set up, but they give you more design flexibility, letting you use any shape, graphic, etc.
- Hotspots are invisible to the student, so they are useful when you want only part of an image to have a certain action, such as parts of a diagram.
Markers

Markers are pre-built interactions consisting of a button (A) and a pop-up label (B). By default, when the student rolls his or her mouse over the marker, the title of the text appears. When the student clicks the marker, the full label appears.

Add a Marker

To add a marker:
1. Go to the Insert tab.
2. Click the Marker button.
3. Select the marker type you want.
4. Click on the slide where you want the marker to appear.
5. Click in the title placeholder, and type the title.
6. Click in the description placeholder, and type the text for the pop-up.

Label Size and Position

The label can be resized and moved to different sides of the marker. If all the text does not fit, a scrollbar appears.

To resize the label, click and drag the resize handles.

To change the position of the label, click and drag the edge to the position you want. There are 12 “stops” around the marker where you can position the label.

POWER TIP

You can add other triggers to the marker, just like you can with other objects.
Use the **Marker Tools: Format** tab for formatting and functional options.

**Change Icon:** Use this drop-down menu to change the icon on the marker.

**Sound:** Use this menu to add sound that plays when the student clicks on the marker.

**Media:** Use this menu to add an image or video to the label. You can have one media file per label and can resize and reposition it by clicking and dragging.

**Animate:** To help draw the students’ attention to the marker, you can have an animation effect. By default, markers have a swirl animation. You can change that to have a pulse animation or no animation.

**Show All On Hover:** By default, only the title shows when the student hovers over the marker, with the rest of the label appearing on mouse click. Check this box if you’d like the entire label to show up when the student hovers over the marker.

**Audio Only:** Check this box if you want to have the marker play a sound without showing a label.

**Marker Styles:** In this section, you have many of the same options for fill and border as you do for other objects. In addition, you can change the color of the marker icon.

**Label Styles:** In this section, you can format the label fill and border. If you want to apply the same formatting to all labels on the slide, click **Apply to All.** (To change the style of several markers at once, just select them all and make the change.)

**Arrange:** You can use the same arrangement tools as with other objects.
**Action Types**

On the following pages, you’ll learn some of the specific details of many of the action types.

### Change State Action

A change state action (not surprisingly) changes the state of an object on the slide. In addition to selecting the action, trigger, and object, you’ll need to select which object will change states (On Object field) and which state it should change to (To state).

DESIGN TIP

You can make a layer disappear automatically when it is finished playing. Just add an action to the layer to hide the layer when its Timeline ends.

### Show Layer/Hide Layer Actions

When you set up a slide layer, it is hidden. Add a **Show layer** action to make a layer visible and a **Hide layer** action if you want to make it hidden again.

If you want to make a layer visible when the slide first loads, add a trigger to the page that starts when the Timeline does, as shown.
Use these actions to go to another slide in the story. Use **Jump to slide** to pick a specific slide and **Jump to scene** to go to the first slide in a scene. You can also pick **next slide/next scene** or **previous slide/previous scene**.

---

**DESIGN TIP**

If you want to go to the beginning of a scene, it is usually better to use **Jump to scene** instead of jumping to the first slide. If you jump to the first slide and then delete or move that slide, your action may not work anymore. But if you jump to the scene, the action always goes to the first slide, even if you rearrange them.
Lightbox Slide/Close Lightbox Actions

A lightbox is a slide that appears as a pop-up window on top of the current slide, with the current slide grayed out and disabled.

When you use the Lightbox slide action, you indicate which slide you want to have appear and whether or not you want the navigational controls (Prev, Next, Submit) on the lightboxed slide.

Lightboxed slides come with a red X as a close button. However, you can create a Close Lightbox trigger. For example, you might want to make your own close button that is more prominent or have the lightbox close automatically when the slide is done playing.

CAUTION
- If you decide to show navigation controls, make sure the lightboxed slides have the controls enabled in Slide Properties.
- A lightboxed slide appears slightly smaller than its full slide. Consider this reduction in size when deciding on font and image sizes for a slide that will become a lightbox.

DESIGN TIP
Navigation controls are useful when you want to show several slides in the pop-up window. For example, you might show a short tutorial on how to use the course. Put all the tutorial slides in one scene, and then lightbox the first slide with navigational controls enabled. Then the student can click through all the slides.
Play/Pause/Stop Media Actions

The play, pause, and stop actions let you control audio and video on your slides independently of the Timeline. For example, if you pause the audio narration on the slide with one of these actions, the Timeline keeps playing and any other objects continue to appear/disappear accordingly. If you have more than one media object on the slide, a media action only affects the media object selected in the Trigger Wizard, not the other media on the slide.

**Play Media**
If you add audio or video using the Insert Sound or Insert Video function on the Insert tab, the media automatically starts playing when the Timeline does—you don’t need an action for that. You would need the Play media action if:

- You want to add media that does not play automatically when the Timeline starts. If you add the media from the Play media Trigger Wizard (instead of the Insert menu) that media does NOT automatically play. It does not play until the Play Media action is triggered.
- You are using the Pause media or Stop media actions. If you pause or stop the media for any reason (such as giving the student stop and pause control), then you’ll probably want a play control to let them start again.

When setting up the Play media action, you’ll select what media you want to control from the Media drop-down menu. You can select a media file already on the slide or choose to import or record sound or video.

**Stop Media and Pause Media**
What’s the difference between Stop media and Pause media? When you stop the media, it returns to its starting point. If you play the media from there, it picks up at the beginning. If you pause the media, it remains where it was paused, picking up again there if you play the media.

---

**POWER TIP**
You can combine the media actions with variables to create user preferences. For example, you can have a question at the beginning of the course asking students if they want to listen to the audio. Then on each slide, include an action that stops the audio if the student answered yes to that question.

Conditions, p. 138  
Variables, p. 133
The **Restart Course** action returns the student to the starting scene and resets all variables, states, etc.

The **Exit Course** button closes the course window.
Use this action to either link to a webpage or launch a document.

To link to a webpage:
1. In the File field, enter the web address you want.
2. Click the Browser options button to configure the properties of the browser window.
3. Click the OK button.

To launch a document:
1. Click the Load file button.
2. Find and select the document you want to launch.
3. Click the Open button.
4. Click the OK button.

Browser Options

Window
Indicate if you want the webpage to display in the current browser window (replacing the course) or open up a new browser window to display the webpage.

Browser Controls
Use this field to determine what controls display in the student's browser.

- Default: Use whatever settings the student has for new browser windows.
- No address bar: Leave all controls except the address bar. This is useful when the students are using computers on which access to websites is restricted.
- No browser controls: Remove all controls from the browser, including the address bar, back button, favorites, etc. Removing all controls can help keep the student focused on the page you are sending them to.

Window Size
- Default: Use whatever size the student's browser determines.
- Full-screen: Open the student's browser window full screen.
- Custom: Enter your own width and height for the browser window. Using a smaller browser window is useful if you want the student to see the webpage and the course at the same time.
**Send Email to**

The **Send Email to** action opens the student’s default email program, addressed to the address in the **Email** field. You can enter more than one email address separated by semicolons.

**CAUTION**

Students must have an email program installed on their computer (such as Outlook) for this action to work. It will not work with a web-based email system (such as Gmail).

**Execute JavaScript**

The **Execute JavaScript** action lets you include custom JavaScript to add functionality that does not come automatically with Storyline.

For example:

- If you are creating a game, you might want some custom functionality that Storyline doesn’t offer.
- You want to include the date or time in the course.
- You want to customize how the course interacts with a Learning Management System.

To add JavaScript, click the **Browse** button (A), and type or paste your code in the pop-up window.
Drag-and-Drop Interactions

To create a drag-and-drop interaction, you don’t need to add interactive objects, such as buttons or checkboxes. Instead, you use regular objects, such as shapes and text boxes, and action triggers based on dragging events or dropping events. This lets you designate an object as “draggable” that can trigger certain actions (such as displaying a layer with feedback) when that object is dropped on something.

**BRIGHT IDEA**

You can also set up a drag-and-drop question using the **Freeform** question type.

Freeform Questions, p. 157

---

### Object Dragged Over Event

Use this event when you want to have something happen when the student drags an object over another, without necessarily dropping it. For example, you might want to have an object glow (change state) when an object is over it so that the student knows that it is a potential drop target.

When you use this event, you will need to select which object can be dragged, and which objects(s) fire the action when dragged over.

<table>
<thead>
<tr>
<th>Trigger Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action:</strong> Change state of</td>
</tr>
<tr>
<td><strong>On Object:</strong> □ Rectangle 1 - “Must Do”</td>
</tr>
<tr>
<td><strong>To state:</strong> Hover</td>
</tr>
<tr>
<td><strong>When:</strong> Object dragged over</td>
</tr>
<tr>
<td><strong>Object:</strong> □ Audit paperwork - “Submit government audit pap...”</td>
</tr>
<tr>
<td><strong>Hover over:</strong> □ Button 1 - “Button 1”</td>
</tr>
<tr>
<td>□ Archiving - “Archiving”</td>
</tr>
<tr>
<td>□ Must Do - “Must Do”</td>
</tr>
<tr>
<td>□ Nice to Do - “Nice to Do”</td>
</tr>
</tbody>
</table>

Show Conditions

- Learn more... [OK] [Cancel]

---

### Object Dropped On Event

Use this event when you want to have something happen when a student drops a dragged item on top of another object. For example, you might want to display a layer with correct feedback if it is dropped on one item, and a layer with incorrect feedback if it is dropped on a different object.

When you use this event, you will need to select which object can be dragged and which object(s) fire the action when dropped on.

<table>
<thead>
<tr>
<th>Trigger Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action:</strong> Show layer</td>
</tr>
<tr>
<td><strong>Layer:</strong> □ Correct</td>
</tr>
<tr>
<td><strong>When:</strong> Object dropped on</td>
</tr>
<tr>
<td><strong>Object:</strong> □ Audit paperwork - “Submit government audit pap...”</td>
</tr>
<tr>
<td><strong>Dropped on:</strong> □ Button 1 - “Button 1”</td>
</tr>
<tr>
<td>□ Archiving - “Archiving”</td>
</tr>
<tr>
<td>□ Must Do - “Must Do”</td>
</tr>
<tr>
<td>□ Nice to Do - “Nice to Do”</td>
</tr>
</tbody>
</table>

Show Conditions

- Learn more... [OK] [Cancel]